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1 About FileWay 

FileWay allows users to have secure remote access to corporate resources over the Internet using their 
browser. With FileWay, users can view, email, manage, download and upload files and folders from any 
location. The following figure shows the end-users’ graphical interface to FileWay.  

 

FileWay comprises the following components: 

·  FileWay FrontEnd 

·  FileWay BackEnd 

·  FileWay Manager 

·  OWA integration (optional) 

·  SecureView BackEnd (optional) 

FileWay FrontEnd provides the FileWay user interface. 

FileWay BackEnd performs the FileWay functions requested by users via the FileWay FrontEnd. 

FileWay Manager is a Windows application that Administrators use to specify users’ access rights for corporate 
drives and shared folders. 

These three components can be installed together on the same server or separately depending on the 
configuration you choose. The figure below shows a typical FileWay installation  

The figure below shows a typical FileWay installation. 

 

Figure 1: Typical FileWay Deployment 

The optional FileWay OWA integration component adds a FileWay button to the OWA tool bar to provide OWA 
users access to FileWay from OWA. See figure below. 

SecureView allows users to view files remotely via their browser without caching files on users’ computers. 



 

 

 

Figure 2: FileWay Integration with OWA 

2 Requirements 

This chapter describes the minimum system requirements for installing FileWay. 

2.1 Hardware Requirements 

Each Intel-based server must be configured with the following: 

·  Minimum Pentium III Processor 500Mhz 

·  Minimum of 512 MB RAM 

·  Minimum 20 GB Hard Disk 

·  Single Ethernet Adapter 
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2.2 Software Requirements 

2.2.1 FileWay FrontEnd Requirements 

·  FileWay FrontEnd should be installed on a member server in the Domain. 

·  Microsoft WindowsTM 2003 or 2008, 2008 R2 Server, Standard, Small Business, or Enterprise 
Edition, 32 bit or 64 bit, any service pack.  Microsoft Internet Information Server TM (IIS) 6 or 
later 

·  If installing the optional FileWay for OWA Integration component, Microsoft Exchange 2003, 
2007 or 2010, is required 

·  Microsoft .NET Framework version 3.5  

·  For Windows 2008 (IIS 7) or Windows 2008 R2 (IIS 7.5) be sure to add the required IIS Role 
Services as specified in the Windows 2008 IIS7 requirements Section 2.4 

·  For Windows 2003 (IIS 6) be sure to configure IIS as specified in the Windows 2003 
Requirements Section 2.5 

 

2.2.2 FileWay BackEnd and FileWay Manager Requireme nts 

·  FileWay FrontEnd should be installed on a member server in the Domain. 

·  FileWay BackEnd and FileWay Manager need to be installed on only one server in the 
domain.  This can be the same server as where FileWay FrontEnd is installed, or a separate 
server. 

·  Microsoft WindowsTM 2003, 2008 or 2008 R2 Server, Standard, Small Business, or Enterprise 
Edition, 32 bit or 64 bit, any service pack 

·  Any of the following SQL Server versions: SQL Server 2000, 2005, 2008, Express Standard 
and Enterprise.  If you do not have an existing database server, FileWay installer will install 
SQL Server 2005 Express Edition during the FileWay BackEnd installation.  

·  For Windows 2008 (IIS 7) or Windows 2008 R2 (IIS 7.5) be sure to add the required IIS Role 
Services as specified in the Windows 2008 IIS7 requirements Section 2.4 

·  For Windows 2003 (IIS 6) be sure to configure IIS as specified in the Windows 2003 IIS 
Requirements Section 2.5 

·  Microsoft .NET Framework version 3.5  

2.2.3 Supported Browsers 

FileWay supports the following browsers: 

·  Internet Explorer 6.0 and up (Windows) 

·  Firefox version 1.5 and up (Macintosh and Windows) 

·  Safari v3.0 and up (Macintosh) 

·  FireFox on Android (Android devices) 



 

 

2.3 Network Requirements 

The FileWay components must be installed in an environment where they are able to communicate with each 
other via TCP/IP and Windows File Sharing. All components will need to be running as members of a Microsoft 
Windows Domain.  

2.4 Windows 2008 IIS Requirements 

Requirements for Installing FileWay Components on Windows 2008 and IIS 7 and Windows 2008 R2 and IIS 
7.5 

1) .NET Framework Version 3.5 (3.5sp1 or sp2) should be installed 

2) IIS 7 Requirements for FileWay BackEnd and FileWay FrontEnd servers 

The IIS Server Role must be installed AND the following "role services" should be selected: 

·  Default Document 

·  Static Content 

·  HTTP Errors 

·  HTTP Redirection 

·  ASP.NET  

·  .NET Extensibility 

·  ASP  

·  ISAPI Extensions 

·   ISAPI Filters  

·  ALL the security roles (Basic, Windows, Digest, etc)  

·  IIS Management Console  

·  IIS 6 Metabase Compatibility 

·  IIS 6 WMI Compatibility 

3) FileWay Update Scheduled Task 

The scheduled task for updating the FileWay Database requires administrative privileges on Windows 2008 
Servers with UAC (User Account Control) activated.   

There are 2 ways to allow this task to run properly: 

a) Disable UAC  

 -- go to Control Panel -> User Accounts ->Turn User Account Control on or off 

 -- uncheck the "Use User Account Control (UAC) to help protect your computer 

 -- click OK, you will have to restart the server 

OR  

b) Give the FileWay Worker account local administrative privileges on the BackEnd Server  

and then modify the scheduled task to run with the highest privileges: 

 - go to Administrative Tools -> Task Scheduler -> Task Scheduler Library  

 - select the task named "FileWayUpdate" 

 - select the task's properties 
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 - on the General Tab make sure the task is set to  

  "Run whether the user is logged on or not" 

  and that  

  "Run with highest privileges"  

  is checked 

 - click OK 

2.5 Windows 2003 IIS Requirements 

Part of the Windows 2003 security options in Internet Information Services (IIS) is to allow the administrator 
to enable the exposing of Active Server Pages (ASP) and Active Server Pages .NET (ASPX) or not.  

Since FileWay is fully-dependent on ASPs and ASPXs, those options have to be allowed in IIS on Windows 
2003. 

To allow ASPs and ASPXs, proceed as follows: 

1. Click Add Remove Programs - >Add Remove Windows Components. 

2. Click Application Server then click the Details Button. 

3. Select ASP.Net (if not selected) then click OK followed by Next and complete the installation process. 

Note: If ASP.Net is already selected, you can exit the setup without having to complete. 

4. From Start menu -> Administration Tools ->Internet Information Services (IIS) Manager 

5. Press on the Web Service Extensions in the tree 

6. On the right hand side there appear three columns containing web service Extension and Status 

7. Read the status of the Active Server Pages web service extension 

If it is Prohibited, allow it (the allow button is to the left of the 3 columns) 

8. Read the status of the following web service extension. 

  ASP .NET v1.1.xxx 

  ASP .NET v2.xxxxx 

9. If they are prohibited, allow them too. 

2.6 Selecting Servers 

Before installing the software, you should select the server(s) on which you will install the FileWay components. 

2.7 Creating a FileWay Account 

The network administrator installing FileWay will need to create a user account in Active Directory for use by 
FileWay (FrontEnd and BackEnd). This account will not need access to anything on the existing network it only 
needs to be a Domain User account. 

The account can be named anything, for example, FileWay Worker. This user account will be referred to as the 
FileWay Worker  account from here on. 



 

 

3 Installing FileWay 

There are two basic approaches to installing FileWay: 

·  Install all components on the same server (known as installing the single-host solution). 

·  Install components on separate servers. How you choose to install the components depends 
on your network environment and preferences.  The FrontEnd server is the component that 
the user connects to through the web.  Some Administrators prefer to have this component 
on a server separate from the FileWay BackEnd server. 

FileWay components should be installed in the following order: 

·  FileWay BackEnd 

·  FileWay FrontEnd 

·  SecureView BackEnd (optional) 

·  OWA integration (optional) 

The procedure for installing FileWay components on separate servers is similar to installing on a single server. 
The only difference is that when you run the installer, you explicitly specify the component you want to install on 
a given server. You specify the components you want to install from the following dialog. 

3.1 Installing FileWay Complete Solution 

1. Run the FileWay v3.X Setup.exe . (note that the name of the Setup.exe changes with the minor 
version – e.g. FileWay v3.4.7 Setup.exe) 

The installation begins and a welcome dialog appears. 
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2. Click Install FileWay  to begin the installation. 

The following dialog appears. 
 



 

 

 
 

3. Click the I accept the terms of the license agreement  button and then click Next . 

The following dialog appears. 
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4. Click the Single-Host: FrontEnd and BackEnd  button to install all FileWay components on the 
same server. 
Click the FileWay BackEnd  button if installind FileWay on separate servers.  FileWay BackEnd 
must be installed before any of the other FileWay components in either scenario 

 

 

 

 

3.1.1 FileWay BackEnd Installation 

5. Click Next . 

The following dialog appears. 
 



 

 

 
 

6. Enter the user name and password you created in Section 2.7 Creating a FileWay Account. 

7. Click Next . 

The following dialog appears. 
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8. Click Go. 
 
The following dialog appears. 



 

 

 

 

Note: If you are installing on a domain controller, the following message appears instead.  
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The following dialog appears. 
 

 

9. Click Go. 

The following dialog appears. 
 



 

 

 
 

10. If you have an existing database instance that you would like to use, type the name of the database 
instance you want to use in the SQL Servers  field. Alternatively, click Get List  to search for 
databases on your network. Setup will display the databases in the SQL Servers  field as shown in 
the figure below. If there is more than one database, you can view them using the pull-down menu. 
 
Please note:  FileWay requires requires a SQLServer Login and thus requires the SQL Server 
Instance that it uses to be configured with Mixed Mode Authentication turned on. Database 
authentication with a Domain account will not work.  The SQL Account you use should have 
Create Database permissions at a minimum.  In addition, the SQL Server Instance should be 
configured to allow Remote Access and allow TCP/IP connections. 
 
If your existing SQL Server Instances are not configured as above, please consider allowing the 
FileWay Installer to install an new Instance of SQL Server Express Edition for FileWay use. See the 
next step for more information 

 
Continue at the next step. 
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Note:  If you do NOT wish to use any of the SQL Server Instances listed or wish to install a new 
instance of SQL Server Express Edition on this computer for FileWay, simply type the machine 
name of the server into the SQL Servers text box  (e.g. “YOUR SERVER MACHINE NAME”). If 
there IS an existing SQL Server Instance on this computer, simply add a new named Instance by 
typing in your server name and an instance name (e.g. “YOUR SERVER MACHINE 
NAME\FILEWAY3”). Then type in any LoginID and Password (these won’t be used) and you should 
see the dialog shown on the next page which will allow you to create a new Instance. Note that you 
DO have to provide a password for the new Database Instance’s “sa” account in the next dialog. 
 
Note: If no databases are found, the dialog shown on the next page will appear. If you want to install 
a SQL Express database, click Yes wait for the SQL Express database installation to complete. If you 
click Cancel , the installation will cancel. 
 



 

 

 
 

11. After the SQL Express database installation completes  

The following dialogue appears 
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12. From the SQL Servers  field, select the database then enter the Login ID and the password for the 
database. 

13. Click Connect . 

FileWay Setup creates the FileWay database. 

14. Click Next . 



 

 

15. The following dialog appears. 
 

 

16. Enter the reference name that you obtained from Everywhere Networks in the Reference Name  field.  

17. Enter your registration key in the Registration Key  field. 
 
If you do not have a registration key and would like to evaluate FileWay, you can obtain a trial license 
by clicking Get Code . When you upgrade your trial license to a full license, you will not  need to 
reinstall the software. You will be given a new license key along with instructions on how to install the 
new key. 

18. Click Next  

The following dialog appears ONLY if you have more than one web site; if it does not appear, 
FileWay Setup will automatically begin installing on the Default Web Site . 
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19. Click Next  

 

 
 



 

 

After a short while, the following dialog appears. 
 

 
 

19. Click Next . 

The following dialog appears. 
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20. Click Next . 

The following dialog appears. 
 

 
 

 
 

21. Click Next. 

The following progress dialog appears. 
 



 

 

 
 
After a moment, the following dialog appears. 
 

 

22. Click Finish . 

The following dialog appears. 
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3.1.2 Installing FileWay Manager 

 

 
 
At this point, FileWay Setup is installing the FileWay Manager component. 

23. Click Next . 



 

 

The following dialog appears. 
 

 

 

24. Click the I accept the terms of the license agreement  button and then click Next . 

The following dialog appears. 
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25. Enter your name and the name of your company and click Next . 

The following dialog appears. 
 

 



 

 

26. Click Next  to install in the default location or click Change  to select a different location in which to 
install FileWay Manager. 

The following dialog appears. 
 

 

27. Click Install . 

The following dialog appears. 
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After a moment, the following dialog appears. 
 

 

28. Click Finish .  



 

 

 

3.1.3 FileWay FrontEnd 

If installing on a Single Server clicking on Finish will launch the FileWay FrontEnd installer.  

If installing on separate servers, click Finish and close the installer on this server.  Then begin the setup on the 
server where you will be installing FileWay FrontEnd.  

Begin the setup and choose the FileWay FrontEnd component option.  Follow the installations steps as below.  

 
 

 
 
At this point, FileWay Setup is installing the FileWay FrontEnd component. 

29. Click Next . 
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The following dialog appears. 
 

 

30. Click the I accept the terms of the license agreement  button and then click Next . 

The following dialog appears. 
 

 



 

 

31. Click Next  to install in the default location or click Browse  to select a different location in which to 
install FileWay. 
 

The following dialog appears.  

 
 
After a moment, the following dialog appears. 
 

 

Click Finish. 
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The following dialog appears. 

 

 

 

 

Select the web site on which you want to install FileWay FrontEnd services then click Next. 
 
Some command prompt windows will appear and then disappear. Then, the following dialog appears. 



 

 

 
 
At this point, File Setup is configuring FileWay to allow end-users to send files as email attachments. 

Click Next , if you want users to have the ability to send files as email attachments via FileWay.  
Otherwise, click Cancel  to return to the main FileWay Setup dialog. 
 
If you lick Next , the following dialog appears. 
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Click the type of mail server you use and then click Next . 
 
If you choose SMTP, the following dialog appears. 
 



 

 

 

 

If you choose Exchange, the following dialog appears. 
 

 

Enter the address of your email server and click Next .  
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The following dialog appears. 
 

 

If applicable to your installation, click SSL when connecting to the Exchange server .  



 

 

The following dialog appears. 
 

 

Click Finish . The following dialog appears. 
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Click Next . 

 

Click Next . 

The following dialog appears confirming that you have installed all the mandatory FileWay 
components. 



 

 

 

Click Next . 

The following dialog appears. 
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3.1.4 SecureView BackEnd 

You may install the SecureView BackEnd component with other FileWay components or on its own 
server. To install SecureView BackEnd on the same server with FileWay components, click Next . 
Otherwise, click Cancel .  

If you click Next , the following dialog appears displaying the user name you specified earlier in this 
procedure. 
 

 

Click Next . 

The following dialog appears. 



 

 

 

 

Select Install SecureView Back-end . Then click Next . 
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The following dialog appears. 
 

 

Click Go. 



 

 

The following dialog appears. 
 

 

After a few moments, the following dialog appears. 
 

 

Click Next . 
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The following dialog appears. 
 

 

Click the I accept the terms of the license agreement  button and then click Next . 

The following dialog appears. 
 

 



 

 

Enter your name and the name of your company and click Next . 

The following dialog appears. 
 

 

Enter the same user name you specified in Section 2.4 Creating a FileWay Account and click Next . 

The following dialog appears. 
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Click Next  to install in the default location or click Change  to select a different location in which to 
install FileWay. 

The following dialog appears. 
 

 

Click Install . 



 

 

The following dialog appears. 
 

 

After a moment, the following dialog appears. 
 

 

Note: Refer to Section 4.5 for important post-installation configuration steps. 

Click Finish . 
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The following dialog appears. 

 
 
 
 

 
 
 

 
 
 

Click Finish . 

       At this point, all FileWay components should be installed.  

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 

 

 

 

       If installing on an Exchange server the option to install FileWay OWA Integration is available.   

       The following Screen appears. 

        

Click Next  to begin the FileWay OWA Integrations installation. 

 

3.1.5 OWA Integration 

The following dialogue appears.  
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Click Go 

The following dialog appears 



 

 

 

Click Go, to verify connection to the FileWay FrontEnd server and  

Click Go, again to Install FilWay OWA Integration.  

The following dialog appears, 
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Click Next. 

The following dialoge appears 



 

 

 

Choose whether to make the ENC Script Modifier available to all users or just the user currently logged on.   
The Script Modifier is used to reinstall FileWay OWA Integration code occasionally after Exchange patches and 
upgrades are applied to the server.  

Click Next. 

The following dialogue appears.  
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Click Next. 

After a few moments the following dialogue appears, 



 

 

 

The Script Modifier is now installed 

Click Close, to continue the OWA Integration installation. 

The following dialogue appears, 
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Click Next. 

 

 

Choose to accept the license agreement  

Click Next  

 



 

 

 

Click Enter  

 

Click Finish  to complete the OWA Integration installation. 
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Click Next. 

 

 



 

 

 

Click Finish.  

 

FileWay OWA Integration is now installed.  To complete the installation follow the post installation steps for your 
version of Exchange: 

Follow the steps in Section 4.1 to configure FileWay for integration with Exchange 2003.  

Follow the steps in Section 4.2 to configure FileWay for integration with Exchange 2007.  

Follow the steps in Section 4.3 to configure FileWay for integration with Exchange 2010.  
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4 Post-Installation Configuration Steps 

·  Optional FileWay integration with Exchange 2003 

·  Optional FileWay integration with Exchange 2007 

·  Optional FileWay integration with Exchange 2010 

·  Enabling SSL if necessary 

·  Configuring the SecureView BackEnd scheduled task if necessary 

·  Enabling Forms Based Authentication for FileWay if necessary. Enable single sign-on for 
FileWay for OWA integration when OWA is set to use SSL or Forms Based Authentication if 
necessary 

·  Customize FileWay 

·  Localize FileWay 

 

4.1 FileWay Integration with Exchange 2003 

If you are integrating FileWay with Exchange 2003 there is one additional post configuration step that 
must be followed to allow FileWay to work properly within OWA.  

Install the ISAPI filter on the website to enable single sign on.  This will allow users to click on the FileWay 
button from within OWA 2007 and not be prompted for authentication again.  

To install the ISAPI filter open IIS Manager.  

- Open the properties of the Default Website.  

- Click on the ISAPI Filters tab. 

- Click on the Add button 

- Enter a name for the ISAPI filter.  Example: FileWay 

- Click browse to locate the ISAPI filter here: Program Files\ENC\FileWay\FileWay 
FrontEnd\ENCISAPIFilter\FileWayISAPI32bit.dll (or choose FileWayISAPI64bit.dll on a 64-bit server) 

- Click OK twice to close the properties windows. 

Now users can click on the FileWay button within OWA and not be prompted for user credentials before 
launching FileWay. 

4.2 FileWay Integration with Exchange 2007 

When integrating FileWay with Exchange 2007 there are a few additional post configurations steps that must be 
followed to allow FileWay to work properly with Exchange 2007. 

1. Install the ISAPI filter on the website to enable single sign on.  This will allow users to click on the FileWay 
button from within OWA 2007 and not be prompted for authentication again.  

To install the ISAPI filter open IIS Manager.  

- Open the properties of the Default Website.  

- Click on the ISAPI Filters tab. 

- Click on the Add button 



 

 

- Enter a name for the ISAPI filter.  Example: FileWay 

- Click browse to locate the ISAPI filter here: Program Files\ENC\FileWay\FileWay 
FrontEnd\ENCISAPIFilter\FileWayISAPI32bit.dll (or choose FileWayISAPI65bit.dll on a 64-bit server) 

- Click OK twice to close the properties windows. 

Now users can click on the FileWay button within OWA and not be prompted for user credentials before 
launching FileWay. 

2. Exchange 2007 enables SSL on the default website and therefore all virtual directories below it have SSL 
enabled as well.  To continue using FileWay with SSL a change in the web.config file is required to complete 
this setup. 

- Open this file for editing with Notepad: Program Files\ENC\FileWay\FileWay FrontEnd\FileWay\web.config 

- Find this section near the bottom 

  <ENC.FileWay.FileWayFrontEnd.Properties.Settings> 

   <setting name="FileWay_FileWayBackEnd_DEWIO_DEWIO" serializeAs="String"> 

    <value>http://servername/FileWayWS/DEWIO.asmx</value> 

   </setting> 

   <setting name="FileWay_FileWayBackEnd_DBLayer_DBLayer" serializeAs="String"> 

    <value>http://servername/FileWayWS/DBLayer.asmx</value> 

   </setting> 

   <setting name="FileWay_FileWayBackEnd_WS_FWBEWS" serializeAs="String"> 

    <value>http://servername/FileWayWS/FWBEWS.asmx</value> 

   </setting> 

  </ENC.FileWay.FileWayFrontEnd.Properties.Settings> 

 

Edit these lines to change http to https and add port 443 as below.  

  <ENC.FileWay.FileWayFrontEnd.Properties.Settings> 

   <setting name="FileWay_FileWayBackEnd_DEWIO_DEWIO" serializeAs="String"> 

    <value>https://servername:443/FileWayWS/DEWIO.asmx</value> 

   </setting> 

   <setting name="FileWay_FileWayBackEnd_DBLayer_DBLayer" serializeAs="String"> 

    <value>https://servername:443/FileWayWS/DBLayer.asmx</value> 

   </setting> 

   <setting name="FileWay_FileWayBackEnd_WS_FWBEWS" serializeAs="String"> 

    <value>https://servername:443/FileWayWS/FWBEWS.asmx</value> 

   </setting> 

  </ENC.FileWay.FileWayFrontEnd.Properties.Settings> 

   

 

Now FileWay is configured to use SSL. 
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3. FileWay will also work fine if OWA is configured to use SSL and FileWay is not.  In this case you will just need 
to uncheck SSL on the FileWay virtual directories: FileWay, FileWayTemp and FileWayWS.   

In this case if you access OWA using https and then click on the FileWay button.  FileWay will launch using 
https from within OWA and function properly. 

4. Exchange 2007 comes with an Exchange certificate.   This certificate is only valid for Exchange it cannot be 
used as a certificate for FileWay.  If you choose to use SSL for FileWay you will need to install a valid certificate 
and remove the certificate that comes with Exchange. 

4.3 FileWay Integration with Exchange 2010 

When integrating FileWay with Exchange 2010 there are a few additional post configuration steps that must be 
followed in order for FileWay to work properly with Exchange 2010.  

1.  Add the ENCAuthModule module in IIS 7 in order to enable single sign on.  This will allow users to 
click on the FileWay button from within OWA 2010 and not be prompted for authentication again.  

- Copy the ENCAuthModule.dll (default location: Program Files\ENC\FileWay\FileWay 
FrontEnd\ENCAuthModule\ENCAuthModule.dll) to the OWA bin folder (default location: Program 
Files\Microsoft\Exchange Server\V14\ClientAccess\Owa\Bin)  

- Open IIS Manager and navigate to the level you want to manage. 

- In Features View, on the server, site, or application Home page, double-click Modules. 

- On the Modules page, in the Actions pane, click Add Managed Module. 

- In the Add Managed Module dialog box, in the Name box, type a name for the managed module, e.g. 
ENCAuthenticationModule 

- In the Type box, enter exactly the following: ENCAuthModule.ENCAuthModule 

- Click OK 

Now users can click on the FileWay button within OWA and not be prompted for user credentials before 
launching FileWay. 

 

2. Exchange 2010 enables SSL on the default website and therefore all virtual directories below it have 
SSL enabled as well.  To continue using FileWay with SSL a change in the web.config file is required to 
complete this setup. 

- Open this file for editing with Notepad: Program Files\ENC\FileWay\FileWay 
FrontEnd\FileWay\web.config 

- Find this section near the bottom 

 <ENC.FileWay.FileWayFrontEnd.Properties.Settings> 

  <setting name="FileWay_FileWayBackEnd_DEWIO_DEWIO" serializeAs="String"> 

   <value>http://servername/FileWayWS/DEWIO.asmx</value> 

  </setting> 

  <setting name="FileWay_FileWayBackEnd_DBLayer_DBLayer" serializeAs="String"> 

   <value>http://servername/FileWayWS/DBLayer.asmx</value> 

  </setting> 

  <setting name="FileWay_FileWayBackEnd_WS_FWBEWS" serializeAs="String"> 



 

 

   <value>http://servername/FileWayWS/FWBEWS.asmx</value> 

  </setting> 

 </ENC.FileWay.FileWayFrontEnd.Properties.Settings> 

 

Edit these lines to change http to https and add port 443 as below.  

 <ENC.FileWay.FileWayFrontEnd.Properties.Settings> 

  <setting name="FileWay_FileWayBackEnd_DEWIO_DEWIO" serializeAs="String"> 

   <value>https://servername:443/FileWayWS/DEWIO.asmx</value> 

  </setting> 

  <setting name="FileWay_FileWayBackEnd_DBLayer_DBLayer" serializeAs="String"> 

   <value>https://servername:443/FileWayWS/DBLayer.asmx</value> 

  </setting> 

  <setting name="FileWay_FileWayBackEnd_WS_FWBEWS" serializeAs="String"> 

   <value>https://servername:443/FileWayWS/FWBEWS.asmx</value> 

  </setting> 

 </ENC.FileWay.FileWayFrontEnd.Properties.Settings> 

 

Now FileWay is configured to use SSL. 

 

3. FileWay will also work fine if OWA is configured to use SSL and FileWay is not.  In this case you will 
just need to uncheck SSL on the FileWay virtual directories: FileWay, FileWayTemp and FileWayWS.   

In this case if you access OWA using https and then click on the FileWay button.  FileWay will launch 
using https from within OWA and function properly. 

4. Exchange 2010 comes with an Exchange certificate.   This certificate is only valid for Exchange it 
cannot be used as a certificate for FileWay.  If you choose to use SSL for FileWay you will need to install 
a valid certificate and remove the certificate that comes with Exchange. 

4.4 Enabling SSL 

Both FileWay FrontEnd and BackEnd support SSL. We recommend that FileWay FrontEnd and FileWay 
BackEnd installations that are externally accessible run under SSL.  

To enable SSL on FileWay FrontEnd or BackEnd, ensure that the website that the applications are installed 
under in IIS, have SSL enabled (or bound in IIS 7) and that you have a SSL certificate installed in IIS.  Then 
require SSL communication for the IIS application under the website. For FileWay FrontEnd, the application is 
named “FileWay” and for FileWay BackEnd, the application is named “FileWayWS”. 

Note:  For FileWay FrontEnd installed on an OWA server for Exchange 2007 or 2010, in default configuration 
SSL is already enabled on the OWA website. 

 

If you have enabled SSL on the FileWay BackEnd, you have to alter the FileWay FrontEnd configuration as 
follows: 

1. On the FileWay FrontEnd server, open the web.config  file in the FileWay installation folder, that is, 
\Program Files\FileWay\FileWay FrontEnd\FileWay\web. config . Note that there are other 
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web.config  files located in other places in your FileWay installation path. Make sure you follow the 
path indicated above.  

2. Go to the lines containing: 

<ENC.FileWay.FileWayFrontEnd.Properties.Settings> 

  <setting name="FileWay_FileWayBackEnd_DEWIO_DEWIO" serializeAs="String"> 

   <value>http://servername:80/FileWayWS/DEWIO.asmx</value> 

  </setting> 

  <setting name="FileWay_FileWayBackEnd_DBLayer_DBLayer" serializeAs="String"> 

   <value>http://servername:80/FileWayWS/DBLayer.asmx</value> 

  </setting> 

  <setting name="FileWay_FileWayBackEnd_WS_FWBEWS" serializeAs="String"> 

   <value>http://servername:80/FileWayWS/FWBEWS.asmx</value> 

  </setting> 

</ENC.FileWay.FileWayFrontEnd.Properties.Settings> 

 

3. Change all occurrences of http  to https  and put the name on the certificate in place of server-name  
(the name on the certificate could be server–name  or server-name.domain-name.com ). Now these 
lines should appear as follows:  

<ENC.FileWay.FileWayFrontEnd.Properties.Settings> 

  <setting name="FileWay_FileWayBackEnd_DEWIO_DEWIO" serializeAs="String"> 

   <value>https://servername:443/FileWayWS/DEWIO.asmx</value> 

  </setting> 

  <setting name="FileWay_FileWayBackEnd_DBLayer_DBLayer" serializeAs="String"> 

   <value>https://servername:443/FileWayWS/DBLayer.asmx</value> 

  </setting> 

  <setting name="FileWay_FileWayBackEnd_WS_FWBEWS" serializeAs="String"> 

   <value>https://servername:443/FileWayWS/FWBEWS.asmx</value> 

  </setting> 

</ENC.FileWay.FileWayFrontEnd.Properties.Settings> 

 

4.5 Configuring the SecureView BackEnd Scheduled Ta sk 

As part of the installation, a scheduled task is automatically created to ensure that SecureView runs 
continuously. In this section, you will configure the scheduled task. 

Proceed as follows to configure the SecureView BackEnd scheduled task: 

1. Open Scheduled Tasks (Start->Control Panel->Scheduled Tasks), right-click SecureView Backend 
and select Properties. 



 

 

2. In the Settings  tab, ensure that Stop the task if it runs for  is not checked. If it is checked, un-check 
it and click OK. 

 
 

4.6 Enabling Forms Based Authentication for FileWay  

By default, FileWay is configured to use Windows authentication. Follow these steps to enable forms 
based authentication for FileWay.  Forms Based authentication is optional. 

1. On the FileWay FrontEnd server, open the web.config file in the FileWay installation folder, that is, 
YourFileWay Installation Path\FileWay\FileWay Front End\FileWay\web.config ). Note that there 
are other web.config files located in other places in your FileWay installation path. Make sure you 
follow the path indicated above.  

2. Scroll down the web.config  file until you find the following section in the file. 

 <!--  AUTHENTICATION  
This section sets the authentication policies of th e application. Possible 
modes are "Windows", "Forms", "Passport" and "None"  
 --> 

     <authentication mode="Windows" /> 
 <!-- 
 <authentication mode="Forms"> 

  <forms name=".FileWayAuth" loginUrl="login.aspx" timeout="20"/> 
 </authentication> 

  <authorization> 
   <deny users="?" /> 
  </authorization> 

 -->  
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3. In the web.config  file, edit the text shown above the file to match the text below.  

 <!--  AUTHENTICATION  

This section sets the authentication policies of th e application. Possible 
modes are "Windows", "Forms", "Passport" and "None"  

  --> 

<!-- 

    <authentication mode="Windows" /> 

--> 

 <authentication mode="Forms"> 

  <forms name=".FileWayAuth" loginUrl="login.aspx" timeout="20"/> 
  </authentication> 
 <authorization> 

  <deny users="?" /> 
 </authorization> 

Note: The changes you must make are highlighted in the two rectangles above. You must move “<!--" 
to just above the <authentication mode = “Windows”/>  line. The other change is that you must 
move “-->” just after the <authentication mode = “Windows”/>  line. The purpose of <!—and -->  is 
to delimit out code that you want to be ignored. 

4. Open IIS Manager and navigate to the FileWay virtual Directory.   

5. Click Properties  and then click the Directory Security  tab.   

6. Click the Edit  button under Authentication and Access control .   

7. Select the check box next to Allow anonymous Access .  

Now when a user logs on to FileWay they will see the following login dialog. 

 

8. You can customize this screen to match your company brand by editing the following file: 



 

 

Program Files\ENC\FileWay\FileWay FrontEnd\FileWay\ login.aspx 

The default greeting is “Enter your login information”. You can change the greeting by editing a key in 
the web.config  file which is located in the following folder:  

YourFileWay Installation Path\FileWay\FileWay Front End\FileWay\web.config   

Edit this key to change the greeting text: 
<add key=" LoginPagePrompt " value="Enter your login information">    </add> 

 

 

5 Customizing FileWay 

There are many ways to customize FileWay to match your company's branding and FileWay also comes with 
the ability to disable and hide many of its features. 

Be aware that any customizations made to FileWay will be lost whenever FileWay is upgraded.  Make note of 
what changes are made so they can be repeated after any upgrades. 

Here are the options available in the FrontEnd web.config to customize FileWay or hide or disable some 
features.  

SmallToolBar - default "false", "true" enables small toolbar bitmaps 
DefaultToolBarStyle - default "Classic", name of directory in images\toolbar that contains the default 
toolbar bitmaps 
CreateFolderToolBar - default "true", "false" removes create folder button from FileWay toolbar 
AllowDownloading - default "true", "false" disables file download, also disables zip & download 
EnableUpload - default "true", false disables file upload 
UploadFileToolBar - default "true", "false" removes upload options from FileWay toolbar/menus 
EnableSecureView - default "true", "false" disables SecureView 
SecureViewToolBar - default "true", "false" removes SecureView options from FileWay toolbar/menus 
EnableEmailFile - default "true", "false" disables email as attachment 
EmailFileToolBar - default "true", "false" removes email as attachment options from FileWay 
toolbar/menus 
EnablePlayMedia - default "true", "false" disables play media 
PlayMediaToolBar - default "true", "false" removes play media options from FileWay toolbar/menus   

Add any of these keys in this format to the FrontEnd web.config 

     <add key=" UploadFileToolBar " value="false"> </add> 

 

5.1 Custom Images 
 

To customize FileWay to match your company’s branding there are several image files that can be replaced 
with custom images.  

The FileWay logo can be replaced with another image. 

The FileWay logo is located in 4 places as there are  4 choices for toolbars. 
When replacing the logo image, make sure to rename the custom image file to match the existing filename of 
logo.gif. 

The four files that need to be replaced are all named logo.gif and are located in these four folders. 

Program Files\ENC\FileWay\FileWay FrontEnd\FileWay\images\toolBar\Classic Look\large 
Program Files\ENC\FileWay\FileWay FrontEnd\FileWay\images\toolBar\Classic Look\small 
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Program Files\ENC\FileWay\FileWay FrontEnd\FileWay\images\toolBar\Vista Look\large 
Program Files\ENC\FileWay\FileWay FrontEnd\FileWay\images\toolBar\Vista Look\small 

For testing make a copy of the Classic Look folder and make edits here in the copy.  Now log on to FileWay and 
go Toolbars, in the menu the copy of Classic Look will be listed in the dropdown.  Choose this new toolbar to 
see your changes while leaving the default toolbars untouched. 

Edit any of the images in these folders; they will change the images on the toolbar buttons.  Be sure to keep the 
file names the same as the default file name. 

Also remember that images are usually cached in the browser, be sure to clear all the temporary internet files 
when testing tosee your changes. 

5.2 Colour 

To change the colour of the interface, edit the ASPX page to change the colour.   
The page to edit can be found here: 
\Program Files\ENC\FileWay\FileWay FrontEnd\FileWay\folderbrowser.aspx 

Only make changes to this file if familiar with ASPX coding or problems may occur.  Be sure to make a backup 
of the folderbrowswer.aspx file before editing it.  

 

6 Localizing FileWay 

This section explains how to localize FileWay for languages other than English US 

1.  Browse to this directory: Program Files\ENC\FileWay\FileWay FrontEnd\FileWay\languages 

2.  Create a new folder that reflects the language shortform.  For Example German (Switzerland) the folder 
name would be de-CH 

3.  Copy the tokens.txt file from the en-US folder to your new language folder. 

4.  Edit the tokens.txt file to translate FileWay messages from English.   

Do not change any text that comes before the "=".  Only edit the text following the "=".  Each entry has a 
description of its function on the right. 

5.   Also located in the Languages folder are several gif files.  These files are English Icons and will also need to 
be translated.  A translated copy of each file should be saved in your new languages folder.  Make sure that the 
name of the file remains the same in English so that FileWay can find the files.  

Similarly, the upload page can be localized 

In FileWay 3.5.0 and later, the text on the Upload page can be localized through the tokens.txt file mentioned 
above, just localize all the messages and upload will be localized..  

In older versions of FileWay (prior to 3.5.0), it can be done as follows: 

1.  Browse to this directory: Program Files\ENC\FileWay\FileWay 
FrontEnd\FileWay\radcontrols\Upload\Localization 

2.  Create a new folder that reflects the language shortform.  For Example German (Switzerland) the folder 
name would be de-CH 

3.  Copy the three XML files (RadProgressArea.xml, RadTemplateUpload.xml, RadUpload.xml) from en-US to 
your new language folder. 

4.  Edit each XML file to translate upload messages from English.  For example: 



 

 

 <string id="TransferSpeed">Speed: </string> 

You will need to translate the Speed: text. 

 

The WebHelp folder can also be translated if you choose.  If not then just copy the existing WebHelp folder to 
your new language folder.  

 

6.1 Zipping and Unicode 

FileWay supports Unicode files in with the Zip and Download function. However older archiving tools, including 
the built in compression tools, do not always support Unicode file names inside of zip archives. If you find that 
your zip and downloaded files do extract successfully but the names of the file(s) inside the archive file are not 
appearing as Unicode text, we recommend that you use the latest version of 7-zip (http://www.7-zip.org) or 
WinRAR to successfully restore the file from the zip files created by FileWay. 

 

7 FileWay and SharePoint Integration 

This chapter describes the steps required to allow users to navigate from SharePoint to FileWay without having 
to authenticate a second time. Section 7.1 below describes several methods of  integrating FileWay with 
SharePoint 2003 integration. Sections 7.2 and 7.3 detail how to integrate FileWay with SharePoint 2007 and 
2010 respectively using the built-in PageViewer WebPart. 

 

7.1 Integrating FileWay with SharePoint 2003 

This scenario applies when SharePoint is installed and a portal is already created, and you want to install 
FileWay and integrate it with SharePoint. Note that FileWay needs to use either a SQL or SQL Server Express 
database. If you do not already have a database that you can use with FileWay, you can install SQL Server 
Express which is provided with FileWay.  

Note: You cannot use the SharePoint database for FileWay 

 

The steps to follow are: 

1. Install FileWay. 

2. Configure IIS. 

3. Configure SharePoint. 

4. Create a Hyperlink Inside SharePoint 

7.1.1 Installing FileWay 

Refer to Section 3  to install FileWay.   

If FileWay and SharePoint are already installed refer to Section 7.1.5  

7.1.2 Configuring IIS 

By default, SharePoint configures IIS to use NTLM authentication. FileWay requires IIS to use Basic 
Authentication. To configure IIS to use Basic  Authentication, proceed as follows: 

Open IIS > ServerName  (Local Computer) > Web Sites  

5. Right-click on Default Web Site  and select Properties  > Directory Security . 
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6. Click the Edit  button in Authentication and Access Control  

7. Ensure that Basic Authentication  is checked and the Default domain  is filled in. 

 

8. Click OK and OK again. You will be prompted for inheritance overrides for FileWay Virtual 
Directories, just click OK for all. 

7.1.3 Configuring SharePoint 

Once IIS is configured to use Basic Authentication, you must configure SharePoint to allow requests to FileWay. 
SharePoint installs an ISAPI filter that blocks with all non-SharePoint web requests, you must change 
SharePoint to allow web requests to FileWay. Proceed as follows: 

Navigate to SharePoint Central Administration . Under Portal Site and Virtual Server Configuration , 
click Configure Virtual Server Settings from the Virtual Server List Page .  



 

 

 

The following page appears. 
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9. Click the portal site. The following page appears. 



 

 

 

10. Under Virtual Server Management , click Define Managed Paths . The following page appears. 
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11. Scroll down to the Add a New Path  section. In the Path  field, enter /FileWay. Ensure the Excluded 
path  radio button is selected and click OK. You will now see FileWay listed in the Excluded Paths  
section.  



 

 

 

Repeat this step to add the following two paths: /FileWayWS and /FileWayTemp. 

12. Using Windows Explorer, browse to the web.config  file for the Default Website , for example, 
C:\inetpup\wwwroot\web.config . Open this file in Notepad to edit it. 

13. Scroll down to the bottom. Look for the <trust level=”wss_minimal”/> tag. Edit this tag so that the trust 
level is Full . 

14. From a command prompt type iisreset  to restart IIS. 

15. Now users will be able to login to FileWay. 

�

7.1.4 Creating a Hyperlink Inside SharePoint 

After configuring SharePoint to allow requests to FileWay, create a hyperlink from SharePoint to FileWay. 

Proceed as follows to create a hyperlink inside SharePoint: 

Log on to the SharePoint Portal http://servername 
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16. Click My Site  

17. Under my links summary  – Add new link  

18. Create a link to FileWay ���������	
�	��
���������  

19. Test the link. You should not be prompted for a username and password a second time. 

�

7.1.5 Setup FileWay in Existing Installations 

If both SharePoint and FileWay are installed, follow these instructions. 

When you create a SharePoint portal, a SharePoint ISAPI filter is added to the website which blocks any 
non-SharePoint web requests, including requests to FileWay. To allow requests to FileWay, follow these 
instructions to create a FileWay friendly SharePoint Portal: 

The steps to follow are: 

1. Create SharePoint Portal  

2. Allow web requests to FileWay 

3. Create hyperlink inside SharePoint 

4. Add FileWay to SharePoint as a WebPart 

 

7.1.6 Create a SharePoint Portal 
·  Go to Start->Programs->SharePoint Portal Server 2003->SharePoint Central Administration-

>Create a portal Site 
·  After the portal has been created, a SharePoint ISAPI filter for authentication is added to the 

Website (e.g. Default Web Site). At the same time, FileWay and any other web application is 
completely dominated by this new portal. 

·  Attempt to login to the portal (usually at http://localhost or http://servername). If you get “You are 
not authorized to view this page”, that’s because no credentials are being submitted to the 
SharePoint server. Go the Default Web Site’s Directory Security tab in IIS and ensure that Basic 
Authentication is checked.  
�  Open IIS>ServerName (Local Computer)>Web Sites 
�  Right click on Default Web Site and select Properties>Directory Security 
�  Click on the Edit button in Authentication and Access Control 
�  Ensure that Basic Authentication is checked and the Domain is filled in. 
�  Click Ok and Ok again. You will be prompted for inheritance overrides for FileWay Virtual 

Directories, just say OK for all. 
·  At this point, should be able to login to the SharePoint portal. It should say the portal name 

followed by Home (e.g. Everywhere Networks Portal, Home). 

 

7.1.7 To allow web requests to FileWay 
·  Go to SharePoint Central Administration. Under Portal Site and Virtual Server configuration. 

Select the link for Configure Virtual Server Settings from the Virtual Server List Page.  
·  From here select the Portal site. 
·  Under Virtual Server Management, select the Define Managed Paths link. 



 

 

·  Scroll down to Add New Path section. In the Path text box enter /FileWay. Make sure the 
Excluded radio button is selected and click OK. You will now see FileWay listed in the Excluded 
path section.  

·  Repeat this for /FileWayWS and /FileWayTemp. 
·  Using Windows Explorer, browse to the web.config file for the Default Website. 

C:\inetpup\wwwroot\web.config. Open this file in Notepad to edit it. 
·  Scroll down to the bottom. Look for the <trust level=”wss_minimal”/> tag. Edit this tag so that the 

trust level is “Full”. 
·  Restart IIS. From a command prompt type “issreset”. 
·  Now will be able to login to FileWay. 

 

7.1.8 Create hyperlink inside SharePoint 
·  Login to the SharePoint Portal http://servername 
·  Click on My Site 
·  Under my links summary – Add new link 
·  Create a link to FileWay http://servername/FileWay 
·  Test the link. You should not be prompted for you username and password a second time. 

 

7.1.9 Quick Fixes To Common Errors  

This section describes common errors that occur when trying to setup single sign on between FileWay 
and SharePoint. 
 

·  When you attempt to login to FileWay, you get the following error: 
·   

Error: “The page cannot be found”   
 
Solution: This reason is that the SharePoint ISAPI filter interferes with the FileWay request. To fix 
this, add “Excluded Paths” to SharePoint. 

 

·  When you attempt to login to FileWay, you get the following error: 

 
Error: “Required permissions cannot be acquired.” 
 

Solution: Open the web.config file for the website (eg. For Default Website, wwwroot/web.config). 
Under the “system.web”  tag, locate the “trust“  tag and ensure that level=”Full” 

 

·  When you attempt to login to your SharePoint Portal, you get the following error: 
 

Error: “You are not authorized to view this page” . 

 

Solution: Go the Web Site’s Directory Security tab in IIS and ensure that Basic Authentication is 
checked. (If after doing this, you get prompted for inheritance overrides for FileWay, just say OK 
for all). 
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7.1.10 How to add FileWay to SharePoint as a WebPar t 

This section describes how to add FileWay to SharePoint as a WebPart. 

Before you can add FileWay to SharePoint as a WebPart, you must have single sign on working as 
described above. 

To add the FileWay Web Part to SharePoint, you need  obtain 2 files. 

The following 2 files are required: 

·  FileWayWebPart.dll – This is the library file for the WebPart. 
·  FileWayWebPart.dwp – This is the description file for the WebPart. 

These files can be found in the setup download in the subfolder FileWay SharePoint 
Integration/SharePoint2007/ 

1 Place the FileWayWebPart.dll in the BIN directory of your webserver root (eg. 
C:\inetput\wwwroot\bin). 

2 Place the FileWayWebPart.dwp in your webserver root (eg. C:\inetput\wwwroot\). 
3 Open the web.config file located in your webserver root (eg. C:\inetput\wwwroot\web.config). 
4 Under the <SafeControls> tag, add the following line: 

<SafeControl Assembly="FileWayWebPart" Namespace="FileWayWebPart" TypeName="*" 
Safe="True" /> 

5 Login to SharePoint 
6 In the left menu, under “Actions”, click on Edit Page.  
7 In the upper right corner, click on Modify Shared Page 
8 In the menu that appears, click on Add Web Parts, then click on Import 
9 In the right pane that appears, click on Browse. 
10 In the dialog that appears, find the description file (FileWayWebPart.dwp) and click Open. 
11 Click on upload. 
12 Click on import. 
13 In the FileWay WebPart title, drill down the menu located on the far right and click on Modify 

Shared WebPart 
14 In the right pane that appears, drill down on Miscellaneus 
15 Modify the src attribute in the Text to point to the FileWay URL. 

 

7.2 Integrating FileWay with SharePoint 2007 

This document describes the steps required to allow users to navigate from SharePoint to FileWay without 
having to authenticate a second time.  

This document assumes that SharePoint 2007 is installed and that a portal is already created. 

The steps to follow are: 

1. Install and configure FileWay. 

2. Configure IIS. 

3. Configure SharePoint. 

4. Create an access point from SharePoint to FileWay. 



 

 

7.2.1  Installing FileWay 

To install FileWay, refer to Section 3  above. 

FileWay must be installed under the SharePoint Website.  If choosing to install FileWay in a two server 
solution, the FileWay FrontEnd must be installed under the SharePoint website.   

�

���������������

�

Once FileWay is installed, a change needs to be made to both the FrontEnd and BackEnd web.config 
files.  

The frontend web.config is located here:  

C:\Program Files\ENC\FileWay\FileWay FrontEnd\FileWay\Web.Config 

The backend web.config is located here: 

 C: \Program Files\ENC\FileWay\FileWay BackEnd\FileWayWS\web.config 

Open web.config with notepad and add this text at the bottom just above </configuration> 

 

<system.web> 

 <trust level="Full" originUrl="" /> 

  </system.web> 

 

Do this for both FrontEnd and BackEnd web.config files. 

 

�
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7.2.2 Configuring IIS 

Once FileWay is installed, configure IIS.  

By default, SharePoint configures IIS to use Windows authentication. FileWay requires IIS to use Basic 
Authentication. To configure IIS to use Basic Authentication, proceed as follows: 

1. Open IIS > ServerName  (Local Computer) > Web Sites . 

2. Select the SharePoint – 80  website and click Authentication . 
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7.2.3  Configuring SharePoint 

·  Using Windows Explorer, browse to the web.config  file for the SharePoint Website  
C:\Inetpub\wwwroot\wss\VirtualDirectories\80\web.co nfig .  
Open this file in Notepad to edit it. 



 

 

Do a search in this document for “Trust level”.  You should find this tag  
<trust level=”wss_minimal”/>. Edit this tag so that the trust level is WSS Medium 
<trust level="WSS_Medium"  

·  From a command prompt type iisreset  to restart IIS. 

Now users will be able to log on to FileWay. 

If, at some point, you remove the portal, and add a new one,  
you will need to repeat the steps in this section. 

 
 

7.2.4 Creating an Access Point from SharePoint to F ileWay 

There are two ways to add a link from SharePoint to FileWay: 

1. Creating a Hyperlink  inside SharePoin t 

2. Adding FileWay  to SharePoint  as a WebPart 
 

7.2.5 Creating a Hyperlink inside SharePoint 

After configuring SharePoint to allow requests to FileWay, create a hyperlink from SharePoint to FileWay. 

Proceed as follows to create a hyperlink inside SharePoint: 

·  Log on to the SharePoint  Portal http://servername. 

·  Click My Site. 

·  Under my links summary  – Add new link. 

·  Create a link to FileWay ���������	
�	��
��������� . 

·  Test the link. You should not be prompted for a username and password a second time. 
 
 

7.2.6 Adding FileWay to SharePoint as a WebPart 

This section describes how to add FileWay to SharePoint as a WebPart. Before you can add FileWay to 
SharePoint as a WebPart, you must have single sign-on working above. 

Proceed as follows: 

Log on to SharePoint as Administrator. Add Page Viewer Web Part. 

 



  

FileWay Administrator’s Guide   81 

 

 

 

 

Go to Site Action, click Edit Page . 
 

 

The above screen will open. Click on Add a Web Part . 



 

 

 

 

The above screen will open. Click on All Web Parts  to expand it. 

 

The above screen will open.  Check Page Viewer Web Part , and click Add  button. 
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The above screen will open. Choose edit , and click on Modify Shared Web Part . 

 

 

The above screen will open. Type the FileWay URL. Then, click on Appearance  to expand it. 

 



 

 

 

 

Type the title in Title  textbox .  Give the Height  and width , Click on Apply .  You will see FileWay in the 
web part. Adjust Height and Width to meets your needs. Click OK. 

 

 

 

Choose Page, click on Save and Stop Editing . 
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Above screen shows FileWay in Page Viewer Web Part . 



 

 

 

7.3 Integrating FileWay with SharePoint 2010 

This document describes the steps required to allow users to navigate from SharePoint 2010 to FileWay 
without having to authenticate a second time. 

 

This document assumes that SharePoint is installed and that a portal is already created. 

 

The steps to follow are:  

1. Install and configure FileWay . 

2. Configure IIS. 

3. Configure SharePoint  

4. Create an access point  from SharePoint  to FileWay . 

 

7.3.1 Installing FileWay 

To install FileWay, refer to Section 3  above. 

 

FileWay must be installed under the SharePoint Website. If choosing to install FileWay in a two server 
solution, the FileWay FrontEnd must be installed under the SharePoint website. 
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Once FileWay is installed, a change needs to be made to both the FrontEnd and BackEnd web.config 
files. 

The FrontEnd web.config is located here: 

C:\Program Files\ENC\FileWay\FileWay FrontEnd\FileWay\web.config 

 Or if it is 64bit system, 

C:\Program Files (x86)\ENC\FileWay\FileWay FrontEnd\FileWay\web.config 

The BackEnd web.config is located here: 

C:\Program Files\ENC\FileWay\FileWay BackEnd\FileWayWS\web.config 

 Or if it is 64bit system, 

C:\Program Files (x86)\ENC\FileWay\FileWay BackEnd\FileWayWS\web.config 

 

<system.web> 

 <trust level=”Full” originUrl=”” /> 

</system.web> 

 

Do this for both FrontEnd and BackEnd web.config files. 



 

 

 

7.3.2 Configure IIS 

Once FileWay is installed, configure IIS. 

By default, SharePoint configure IIS to use NTLM authentication. FileWay requires IIS to use Basic 
Authentication.  

To configure IIS 7.0 to use Basic Authentication, proceed as follows: 
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7.3.3 Configuring SharePoint 

To configure SharePoint 2010, proceed as follows: 
1. Using  Windows Explorer, browse to the web.config  file for the SharePoint Website , 

C:\Inetpub\wwwroot\wss\VirtualDirectories\80\web.co nfig . 
2. Open this file in Notepad to edit it. 
3. Do a search in this document for “Trust level”. You should find this tag 

<trust level=”wss_minimal”/>. Edit this tag so that the trust level is WSS Medium 
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<trust level="WSS_Medium" 
4. From a command prompt type iisreset to restart IIS. 

 

Now users will be able to log on to FileWay. 

 

7.3.4 Creating an Access Point from SharePoint to F ileWay 

There are two ways to add a link from SharePoint to FileWay: 
1. Creating a Hyperlink  inside SharePoint  
2. Adding FileWay  to SharePoint  as WebPart  

 

7.3.5 Creating a HyperLink inside SharePoint 

After configuring SharePoint to allow requests to FileWay, create a hyperlink from SharePoint to FileWay. 

Proceed as follows to create a hyperlink inside SharePoint: 
·  ��#��������

� ���
������ �$����	� 
���%&&�
�'
����
 ��

·  �	��"� ����� ��

·  �	��"� ����� ��

·  (��
���

�  �������

�
! �)� �""���#� ��� ��

·  ��
��
���	��"���� $� ���! �
���%&&�
�'
����
&*�	
+�, �

·  -
����

�	��"��.����
��	�������
�������
��/�������
 ����
�����������������
��������
��



 

 

7.3.6 Adding FileWay to SharePoint 2010 as a WebPar t 

This section describes how to add FileWay to SharePoint as a WebPart.  

Proceed as follows: 

Log on to SharePoint 2010 as Administrator. Add Page Viewer Web Part. 

 

 

Choose Site Action , and click Edit Page . 

 

Above screen will open. Click Insert  Tab. 
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On above screen, click Web Part . 

 

Above screen will open. Select Media and Content  in Categories , then, select Page Viewer in Web 
Parts . Click Add  button. 

 



 

 

 

 

Above screen will open. Click open the tool panel . 

 

 

 

Above screen will open. Enter FileWay URL. Then, expand Appearance . 
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Enter the title in Title textbox.  Enter the Height and width, click on Apply .  You will see FileWay in the 
web part. Adjust Height and Width to meets your needs. Click OK. 

 

Above screen will open. Click Save & Close  to exit editing page. 



 

 

 

 

 

Above screen shows FileWay in Page Viewer Web Part . 
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8 FileWay Concepts 

As an Administrator, you can specify access rules on an individual user basis. However, this approach 
can become unmanageable in an organization with more that 25 users.  

A more efficient approach is to specify access rules for many users at a time based on a variety of 
criteria.  

Both approaches are described below. 

8.1 Rule Sets  

Rule sets comprise the following elements: 

·  Members 

·  Resources 

Rule sets combine members (i.e. users) and resources to create access rules in a way that is logical for a 
given rule set. For example, a rule set called Sales could contain all employees working in the Sales 
department and would provide those employees with access to the resources that they need. 

8.1.1 Rule Set Resources 

Resources contain multiple references to folders and shares from different computers and servers. 
Resources can also contain multiple references to computers. Refer to the two following figures. 
 

    

 

 

 



 

 

8.1.2 Rule Set Members 

Members can contain references to individual users, groups and organizational units in your Active 
Directory. Rule sets can also contain references to other rule sets. A user can be a member of multiple 
rule sets. Refer to the two following figures.  
 

 

 

 

 

8.2 Individual Users 

Some users will require resources that are unique to them. In such cases, a rule set would only have one 
member; therefore, it is more practical to assign resources to those individual users. This is achieved 
using virtual machines. 

To assign resources to an individual user, you must create a virtual machine for that user. The user must 
already exist in Active Directory. Then you add resources to the virtual machine. Refer to the figure below 
to see virtual machines assigned to a user. In this example, user John Smith has a virtual machine called 
Special  that contains the Specialized Equipment  resource. Therefore, John would have access to that 
resource. 

A user may have more than one virtual machines. One reason to use multiple virtual machines is to 
organize resources in a particular way for a given user. 

Note that adding a virtual machine with resources to individual users does not preclude those users from 
being members of one or more rule sets. 
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Virtual 
Machines 



 

 

9 Planning Access Rules for Multiple Users 

As described in the concepts section above, you have several components to work with: individual users 
and groups in your Active Directory, rule sets, folders, shares and computers. You should plan how to 
group these components.  

Begin with rule sets. Rule sets can be named according to functional groups within your organization, for 
example, Sales, Marketing , Engineering  and Research  could be four rule sets. The name of the rule 
set will appear to end-users as a virtual machine w hen they login to FileWay.  Rule sets can have 
imbedded rule sets; for example, if you needed a rule set called Sales & Marketing , you could add the 
existing Sales rule set and the Marketing  rule set. 

Next, decide which members should be part of a given rule set (i.e. users, groups and imbedded rule 
sets). These users and groups come from your organization’s Active Directory. For example, a rule set 
called Sales would likely contain one or more existing groups or Organizational Units and maybe 
individual users or imbedded rule sets as required. 

Next, decide which resources must be added the Sales rule set. Resources are a collection of references 
to folders, shares and computers. 

Once you have planned your rule sets, members, resources and attributes, start using FileWay Manager.
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10 Using FileWay Manager 

10.1 Starting FileWay Manager 

FileWay Manager should have been installed on the same server as the FileWay BackEnd Server. There 
should be a short cut on the desktop to start FileWay Manager. Double-click the short cut to start FileWay 
Manager. 

 
 

When you first run FileWay Manager, the 
FileWay Manager main window appears 
displaying the Individual Users  and Rule Sets  icons in the left pane of the main window. 

 

10.2 Stopping FileWay Manager 

To stop FileWay Manager,  click File > Exit . 

You will be prompted to update the FileWay Database. If you update the FileWay Manager database, any 
changes you made since the last time the database was updated will take effect. This is important if you 
changed access privileges in some way, for example, deleting a rule set. 

If you do not update the FileWay Manager database, any changes you made since the last time the database 
was updated will only take effect the next time the FileWay Manager scheduled task is executed. 



 

 

10.3 Creating Access Rules for Multiple Users 

10.3.1 Creating a Rule Set 

To create a rule set, proceed as follows: 

1. Right-click the Rule Sets  icon. 

A pop-up menu appears. 

2. In the pop-up menu, click Create Rule Set . 

The Create Rule Set  dialog appears. 

 

3. In the Virtual Machine Name  field, enter a name for the rule set, for example, Sales. 

End-users will select this virtual machine to access the resources of the rule set. 

4. Click the Include Home Directories  Folders  check box if you want users to be able to access their 
home directory. 

5. Click Create Rule Set . 

The main FileWay Manager window re-appears displaying the new rule set in the right pane. 

6. Double-click the new rule set to expand it. 

The two elements of the new rule set appear: Members and Resources. Refer to the figure below. 

 

 
 

10.3.2 Adding Members to a Rule Set 

Members can be groups, users and other rule sets.  

Note: The next 3 procedures assume that the Members  and Resources  icons appear in the left and right 
panes for the selected rule set as shown in the previous figure. If necessary, expand the Rule Sets  icon and/or 
the rule set you want to modify. 
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10.3.3 Adding Groups to a Rule Set 

1. Right-click Members . 

A pop-up menu appears. 

 

 

2. From the pop-up menu, click Edit Group List . 

The Edit Group List dialog appears. Use this dialog to search for the group(s) you need, for 
example, Sales. 

If the group of users that you would like to add are contained in an Organizational Unit (OU), then you 
can choose Edit Organizational Unit List. From here you can search for the OU you need.  The steps 
are exactly the same as they are for adding a Group. 



 

 

 

3. Select the Domain from which you want to add a group. 

Note: Before you can select trusted domains, you must first add the trusted domains to the FileWay 
domain list. Refer to Adding Trusted Domains in Section 8.1 

4. In the Starts With  field of the Edit Group List  dialog, enter the name of the group you want and click 
Search  to find the group in Active Directory. 

If you prefer to browse for the group name, enter nothing in the Starts With  field and click Search . 

The result of the search appears below the Search Results  list. 

5. Select one or more groups you want, and click Add Groups . You can also double-click a group to 
select it. 

The selected groups appear in the Members  list. 

6. Click OK when you have selected all the groups you need. 

The main FileWay Manager window reappears displaying the group(s) you just added. The domain to 
which the group belongs also appears. 
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10.3.4 Adding Users to a Rule Set 

The process for adding users is almost identical to adding groups. From the Members  pop-up menu, 
select Edit User List  and the Edit User List  dialog appears. From that point, the process  is the same as 
adding groups. 

10.3.5 Adding Other Rule Sets to a Rule Set 

The process for adding rule sets to another rule set is almost identical to adding groups. From the 
Members  pop-up menu, select Edit Rule Set List  and the Edit Rule Set List  dialog appears. From that 
point, the process  is the same as adding groups. 

In the figure below, you can see that the Students rule set is imbedded into the Test rule set. This means that 
users who are members of the Students rule set can also access the resources specified in the Test rule set. 



 

 

 

10.3.6 Adding Resources to a Rule Set 

There are two approaches to specifying resources within a rule set:  

·  You may specify a computer, share or a folder within a share to be accessible by all 
members of the ruleset. 

·  You may specify a custom resource with fields that are replaced when the resource is written 
to the FileWay database. 

10.3.7 Assigning Resources to Members of a Rule Set  

Proceed as follows to add resources to your rule set: 

Note: This procedure assumes that the Members  and Resources  icons appear in the right and left panes for 
the selected rule set as shown below. If necessary, expand the Rule Sets  icon and/or the rule set you want to 
modify. 

 

   

1. Right-click Resources  and select Add Resources  from the pop-menu. 

The Add Resources dialog appears. 
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2. Expand the various items in the left pane until you locate the folder(s), share(s) or computer(s) that 
are applicable to your rule set.  

3. To select a resource from this dialog, right-click the resource and click Add Resources .  

The main FileWay Manager window re-appears displaying the resource you added in the right pane. 

 

Note:  When you add a computer to a rule set’s resources, only the computer’s shares will be 
accessible to the members of the rule set. Also, the computer will appear to users as a network drive 
icon instead of a computer icon. Refer to the figure below. 



 

 

 

At this point, you have created a rule set containing users and resources.  

Repeat the process to create more rule sets. 

10.3.8 Assigning Custom Resources to Members of  Ru le Set 

FileWay Manager provides assignable fields that you can use when assigning resources to a rule set. The fields 
are: %groupname% and %username% . 

This approach simplifies the creation of custom rule sets for individual groups or users; without the fields, you 
would need to create a separate rule set for each user and/or group.  

Proceed as follows to add custom resources to your rule set: 

Note: This procedure assumes that the Members  and Resources  icons appear in the right and left panes for 
the selected rule set as shown below. If necessary, expand the Rule Sets  icon and/or the rule set you want to 
modify. 

 

   

1. Right-click Resources  and select Add Custom Resource  from the pop-menu. 
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The Add Custom Resource dialog appears. 
 

 

2. Browse to the location of the resource you want to add. 

3. Once the path to the resource appears in the field at the bottom of the Add Custom Resource 
dialog, type a backslash at the end of the path. 

4. Click %username%  to insert the user name field in the resource path. This will be replaced by the 
current user name when the rule set information is written to the FileWay database. Click 
%groupname%  to insert the group name field in the resource path. This will be replaced by the 
current group name when the rule set information is written to the FileWay database. 

The main FileWay Manager window re-appears displaying the resource you added in the right pane. 
 

 

5. Many users who have a large environment with a lot of computers and users find it easier to just type 
in the UNC path to a resource. This can be done from the Add Custom Resource  dialog.  



 

 

 

Also if you have a large environment you may know the server where your resource is located but still 
need to browse to find a share. You can enter the server name and then click Browse  and only the 
shares on that server will appear.  

10.3.9 Viewing Members of a Rule Set 

Within of a rule set, you can view the members of groups and the members of imbedded rule sets. In the figure 
below, you can see that the Engineering rule set is imbedded into the Sales rule set. 

Note: The following procedures assume that the rule set members appear in the right pane as shown below. If 
necessary, expand the Rule Sets  icon and/or the rule set for which you want to view the members. 

 

 

10.4 Viewing Members of Group within a Rule Set 

To view the members of a group within a rule set, proceed as follows: 

1. Double-click the group for which you want to see the members. 

A dialog appears showing the users who are members of the selected group.  

2. Click OK to close the window. 

The main window reappears showing the members of the current rule set. 

10.4.1 Viewing Members of a Rule Set within a Rule Set 

To view the members of an imbedded rule set, proceed as follows: 

1. Double-click the imbedded rule set for which you want to see the members. 
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A window appears showing the users that are members of the selected imbedded rule set. 

2. Click OK to close the window. 

The main window reappears showing the members of the current rule set. 

10.5 Modifying Rule Sets 

You can make the following changes to a rule set: 

·  Change characteristics of the rule set itself 

·  Change its Members 

·  Change its Resources 

Note 1:  When you make any changes in FileWay Manager, and you want the changes to take effect 
immediately, update the FileWay database by selecting the following command from the Tools  menu: Write 
Configuration to FileWay Database . 

Note 2: The following procedures assume that the rule sets appear in the left pane as shown in the following 
figure. If necessary, expand the Rule Sets  icon. 

  

10.5.1 Changing Characteristics of Rule Sets 

You can make the following changes to a rule set: 

·  Rename 

·  Delete 

·  Change properties 

10.5.2 Renaming a Rule Set 

To rename a rule set, proceed as follows: 

1. Right-click the rule set you want to rename.  

A pop-up menu appears. 



 

 

 

2. From the pop-up menu, click Rename Rule Set . 

The name of the rule set is highlighted. 

 
 

3. Type the new name for the rule set and press Enter. 

10.5.3 Deleting a Rule Set 

To delete a rule set, proceed as follows: 

1. Right-click the rule set you want to delete.  

A pop-up menu appears.  

2. From the pop-up menu, click Delete Rule Set . 

A verification dialog appears asking you to confirm the deletion. 

3. Click Yes. 

The rule set is removed from the list of rules sets. 

10.5.4 Changing Rule Set Properties  

To rule set properties, proceed as follows: 

1. Right-click the rule set whose properties you want to change. 

A pop-up menu appears. 

2. From the pop-up menu, click Properties . 

The Rule Set Properties  dialog appears. 

3. Select or deselect the Include Home Directories  check box as required. 

4. Click OK. 

The main FileWay Manager window re-appears. 
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10.5.5 Changing Members of a Rule Set 

Members can be groups, users and other rule sets. 

Note: The following procedures assume that the rule set members appear in the right pane as shown below. If 
necessary, expand the Rule Sets  icon and/or the rule set you want to modify. 

 

10.5.6 Deleting a Single User from a Rule Set 

To delete a user from a rule set, proceed as follows: 

1. Right-click the user that you want to delete and select Delete Members . 

A verification dialog appears asking you to confirm the deletion. 

2. Click Yes. 

The main FileWay Manager window re-appears displaying the remaining members in the right pane. 

10.5.7 Adding or Deleting Multiple Users to or from  a Rule Set 

To add and/or delete multiple users from a rule set, proceed as follows: 

1. Right-click Members  in the left pane. 

A pop-up menu appears. 

2. From the pop-up menu, click Edit User List . 

The Edit User List dialog appears displaying users that are already members of the rule set.  

Use this dialog to search for the user(s) you need. 

3. In the Starts With  field of the Edit User List  dialog, enter the name of the user that you want to add. 

If you prefer to browse for the group name, enter nothing in the Starts With  field and click Search . 

The result of the search appears below the Search Results  list. 

4. Select one or more users that you want, and click Add Users . You can also double-click a user to 
select it. 

The selected users appear in the Members  list. 

5. You can delete multiple users from the rule set by selecting them in the Members  list and clicking 
Remove . A verification dialog will appear asking you to confirm the deletion. 



 

 

6. Click OK in the Edit User List dialog when you have selected all the users you need. 

The main FileWay Manager window reappears displaying the users(s) you added.  

10.5.8 Deleting a Single Group from a Rule Set 

To delete a group, proceed as follows: 

1. Right-click the group that you want to delete and select Delete Group .  

A verification dialog appears asking you to confirm the deletion. 

2. Click Yes. 

The main FileWay Manager window re-appears displaying the remaining members in the right pane. 

10.5.9 Adding or Deleting Multiple Groups to or fro m a Rule Set 

The process for adding and/or deleting multiple groups is almost identical to adding and/or deleting 
multiple users. From the Members  pop-up menu, select Edit Group List  and the Edit Group List  dialog 
appears. From that point, the process  is the same as adding and/or deleting multiple users. 

10.6 Deleting a Single Rule Set from a Rule Set 

To delete a rule set within a rule set, proceed as follows: 

1. Right-click the rule set that you want to delete and select Delete Rule Set .  

A verification dialog appears asking you to confirm the deletion. 

2. Click Yes. 

The main FileWay Manager window re-appears displaying the remaining members. 

10.6.1 Adding or Deleting Multiple Imbedded Rule Se ts to or from a Rule Set 

The process for adding and/or deleting multiple rule sets within one rule set is almost identical to adding 
and/or deleting multiple users. From the Members  pop-up menu, select Edit Rule Set List  and the Edit 
Rule Set List  dialog appears. From that point, the process  is the same as adding and/or deleting 
multiple users. 

10.6.2 Changing Resources of a Rule Set 

Note: The following procedures assume that the rule set members appear in the right pane as shown below. If 
necessary, expand the Rule Sets  icon and/or the rule set you want to modify. 

 

10.6.3 Deleting a Single Resource from a Rule Set 

To delete a resource, proceed as follows: 

1. Right-click the resource that you want to delete and select Delete Resources .  
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A verification dialog appears asking you to confirm the deletion. 

2. Click Yes. 

The main FileWay Manager window re-appears displaying the remaining resources. 

10.6.4 Adding Resources to a Rule Set 

To add a resource to a rule set, proceed as follows: 

1. Within the relevant rule set, right-click Resources  and select Add Resources  from the pop-menu. 

The Add Resources dialog appears. 

2. Expand the various items in the left pane until you locate the folder(s), share(s) or computer(s) that 
are applicable to your rule set. These would be resources that only members of the rule set may 
access.  

3. To select a resource from this dialog, right-click the resource and click Add Resources .  

The main FileWay Manager window re-appears displaying the resource you added. 

 

4. Repeat until you have selected all the resources you need. 

Note:  When you add a computer to a rule set’s resources, only the computer’s shares will be 
accessible to the members of the rule set, more specifically, the FileWay end-users. Also, the 
computer will appear to end-users as a network drive icon instead of a computer icon. Refer to the 
figure below. 

 



 

 

10.6.5 Adding Custom Resources to Members of  Rule Set 

FileWay Manager provides assignable fields that you can use when assigning resources to a rule set. The fields 
are: %groupname% and %username% . 

This approach simplifies the creation of custom rule sets for individual groups or users; without the fields, you 
would need to create a separate rule set for each user and/or group.  

Proceed as follows to add custom resources to your rule set: 

1. Right-click Resources  and select Add Custom Resource  from the pop-menu. 

The Add Custom Resource dialog appears. 

2. Browse to the location of the resource you want to add. 

3. Once the path to the resource appears in the field at the bottom of the Add Custom Resource 
dialog, type a backslash at the end of the path. 

4. Click %username%  to insert the user name field in the resource path. This will be replaced by the 
current user name when the rule set information is written to the FileWay database. Click 
%groupname%  to insert the group name field in the resource path. This will be replaced by the 
current group name when the rule set information is written to the FileWay database. 

The main FileWay Manager window re-appears displaying the resource you added in the right pane. 

5. Repeat until you have added all the custom resources you need. 

10.7 Creating Access Rules for Individual Users 

Sometimes, rule sets may not the best approach for assigning resources to a user. In this case, you can 
assign resources to individual users.  

To assign resources to individual users, you must create one or more virtual machines for each individual 
user. The user must already exist in Active Directory. Then you add resources to the appropriate virtual 
machine. One reason to use multiple virtual machines per user is to group the resources in a particular 
way. Refer to the figure below to see virtual machines assigned to individual users. 

 

When a user logs on to FileWay, the virtual machines for individual users appear with other virtual 
machines, if any. See the figure below. The new virtual machine for an individual user in this example is 
called: Special . 
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10.7.1 Adding a User 

To add an individual user, proceed as follows: 

1. Right-click the Individual Users icon. 

A pop-up menu appears. 

2. In the pop-up menu, click Edit User List . 

The Edit User List dialog appears displaying a list of users who already have had resources 
assigned directly to them. 

Use this dialog to search for the user that you want to add. 

3. In the Starts With  field of the Edit User List  dialog, enter the name of the user you want and click 
Search  to find the user in Active Directory. 

If you prefer to browse for the user name, enter nothing in the Starts With  field and click Search . 

The result of the search appears in the Search Results  list. 

4. Select one or more users you want, and click Add Users . You can also double-click a user to select 
it. 

The selected user(s) appear in the Members  list. 

5. Click OK when you have selected all the users you need. 

The main FileWay Manager window reappears displaying the user(s) you just added.  

10.7.2 Adding a Virtual Machine to a User 

To add a virtual machine to a user, proceed as follows: 

1. Right-click the relevant user.  

A pop-up menu appears.  

2. From the pop-up menu, click Add Virtual Machines . 

The Add Virtual Machines  dialog appears. 

3. Click Create Virtual Machine . 

The Create Virtual Machine  dialog appears. 

4. Enter the name of the Virtual Machine . 



 

 

5. Click Create Virtual Machine . 

The name of virtual machine appears below the user. 

You may add as many virtual machines as required. 

10.7.3 Adding Resources to a Virtual Machine 

To add a resource to an individual user’s virtual machine, proceed as follows: 

1. Right-click a virtual machine and select Add Resources  from the pop-up menu. 

The Add Resources dialog appears. 

2. Expand the various items in the left pane until you locate the folder(s), share(s) or computer(s) that 
are applicable to the user.  

3. To select a resource from this dialog, right-click the resource and click Add Resources .  

The main FileWay Manager window re-appears displaying the resource you added. 

4. Repeat until you have selected all the resources you need. 

Note:  When you add a computer to a rule set’s resources, only the computer’s shares will be 
accessible to the relevant FileWay end-user. Also, the computer will appear to end-users as a 
network drive icon instead of a computer icon. Refer to the figure below. 

 

10.7.4 Deleting a User 

To delete an individual user, proceed as follows: 

1. Right-click the user you want to delete. 

A pop-up menu appears. 

2. In the pop-up menu, click Delete User . 

A confirmation dialog appears. 

3. Click Yes to confirm the deletion. 

The main FileWay Manager window reappears displaying the remaining user(s).  

10.7.5 Renaming a User's Virtual Machine 

To rename a user’s virtual machine, proceed as follows: 

1. Right-click the virtual machine that you want to rename.  

A pop-up menu appears. 
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2. From the pop-up menu, click Rename Virtual Machine . 

The name of the rule set is highlighted. 

3. Type the new name for the rule set over the old and press Enter. 

10.7.6 Deleting a User's Virtual Machine 

To delete an individual user’s virtual machine, proceed as follows: 

1. Right-click the user you want to delete. 

A confirmation dialog appears. 

2. Click Yes to confirm the deletion. 

The main FileWay Manager window reappears displaying the remaining virtual machines.  

10.7.7 Deleting a Resource from a User's Virtual Ma chine 

To delete a resource, proceed as follows: 

1. Display the user’s resources in the right pane of FileWay Manager. You may need to expand the 
user’s name and possibly double-click the virtual machine name. 

2. Right-click the resource that you want to delete and select Delete Resources .  

A verification dialog appears asking you to confirm the deletion. 

3. Click Yes. 

The main FileWay Manager window re-appears displaying the remaining resources. 

10.8 Adding Icons for New File Types 

If you notice that a certain file type does not have an icon in FileWay, you can add an icon for that file type in 
FileWay Manager. For example Office 2007 now uses the extension docx for Word documents. You can 
associate this type of  file with an icon so that it will now have the Word icon rather than a generic icon.   

To associate a file type with an icon, proceed as follows:  

1. In FileWay Manager, click Tools  in the menu bar and then choose File Image Editor. The following 
dialog appears. 



 

 

 

The database already contains a number of icons that are associated with file types.   

2. To add a new file type, type the extension in the Extension field. Then type the image file name, for 
example, extension docx and the Word doc icon. 
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If you need to add a custom icon that is not listed, please contact support for the complete instructions.  
support@everywherenetworks.com 

10.9 End-User Notes 

The figure below shows an end user’s view of FileWay. When end-users log on to FileWay using their 
browser, the Address  pull-down menu lists the names of the virtual machines to which each user has 
access. In this example, the virtual machines are: Engineering, HW, SW and Special.  

From your point of view, as the FileWay Manager Administrator, you recognize the first three virtual 
machines as rule sets, and the fourth as a virtual machine assigned to a specific user. To the user, it 
makes no difference whether the virtual machines correspond to a rule set or to a virtual machine 
assigned to a specific user. In this example, user John Smith has a virtual machine called Special  that 
contains the Specialized Equipment  resource. Therefore, John would have access to that resource (in 
addition to other virtual machines if applicable). 



 

 

 

End-users can create shortcuts to files or folder within any of their virtual machine(s). See the figure below for an 
example of a short cut. 

 

If you rename a rule set, members of the rule set will lose their shortcuts that were created on the virtual 
machine.  

Similarly if you rename a virtual machine, the user will lose all the shortcuts created on the old virtual machine. 

FileWay end users simply need the URL to FileWay. The URL must have the form: 
http://www.companydomainname.com/fileway>. 
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11 Managing the FileWay Database 

11.1 Adding Trusted Domains 

When creating rule sets, you can choose users, groups and resources from trusted domains within your 
organization; however, before you can access trusted domains from within FileWay, you must add the trusted 
domains to the list of domains that FileWay can use. 

Proceed as follows: 

1. Click Tools > Domain List . 

 

The following dialog appears listing all the trusted domains within your organization. The host domain 
is the one in which FileWay is installed. 

 

2. Select the trusted domain you want and click Add Domains . 

3. Click OK to finish 
 



 

 

 

11.2 Viewing the Current Contents of the Database 

Select Tools > Show FileWay Database  to get a quick and complete view of all rule sets and their members 
and resources, as well as individual users and their virtual machines and resources. Refer to the figure below.  

Note that you should update the FileWay Manager database before viewing the contents of the database in this 
manner. Viewing the database in this way allows you to quickly check whether changes you made in FileWay 
Manager were written to the database.  

Viewing the database is useful for debugging purposes, for instance, to check if a certain user has access to a 
certain resource.  

 
 
 

 

11.3 Scheduling Daily Updates for FileWay Manager D atabase 
 

You can configure FileWay Manager to automatically update the FileWay Manager database on a scheduled 
basis. Click Tools > Schedule FileWay Database Updates  and the following dialog appears. 
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Select the schedule that suits your requirements and click OK. 

Note: if you choose to schedule updates to the database, keep in mind that if you make changes in FileWay 
Manager hat must be applied immediately, use the procedure in the next section. 

 

11.4 Updating the Database with Latest Changes 

When you make any changes in FileWay Manager, and you want the changes to take effect immediately, 
update the FileWay database by selecting the following command from the Tools  menu: Write Configuration 
to FileWay Database . 

If changes are made to Active Directory that impact FileWay, for example, removal of users or groups, run Write 
Configuration to FileWay Database . If you find that the changes were not propagated to FileWay Manager, 
Active Directory will need to be closed and re-opened. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

12 Troubleshooting 

Below we list some of the frequently encountered issues when installing or administering FileWay and 
solutions thereto. 

 

12.1 Licensing error when writing changes to the Fi leWay database when 
using FileWay Manager 

Issue :  
While writing changes to the FileWay database using FileWay Manager, an “Error: License Invalid.” error 
message is displayed. 
Fix :  
In order to resolve the licensing error, the database needs to be reset. To reset the database. Follow 
these steps: 
1. Make a copy of your RuleSet text file (default location is: Program Files\ENC\FileWay\FileWay 
Manager\RuleSets.txt) 
2. Open the Command Prompt 
3. CD to FileWay Manager directory (default location is: Program Files\ENC\FileWay\FileWay Manager\) 
4. Run the following command: FileWayUpdate -R 
5. Open FileWay Manager > Tools > Write Configuration to FileWay Database 
6.To avoid this problem in future, please remember to Write your changes to the database after deleting 
any users/groups or RuleSets and prior to adding new users, groups or RuleSets. 
 

12.2 FileWay button disappears from OWA 
 

Issue:  
The FileWay button is no longer visible in OWA when it was previously. 
Fix: 
FileWay comes with a tool called the Script Modifier, this tool inserts FileWay code into existing Exchange 
files during installation. It can also be used to insert FileWay code back into Exchange after an Exchange 
hotfix or Service Pack has been installed which may have replaced some Exchange files 
 
1. Edit (i.e open with notepad or other text editor) \Program 
Files\ENC\ENCScriptModifier\PSTWayInstall.bat  
2. Edit it to read as follows - OWAJScriptModifier.exe filewayfrontend insert 
3. Save the .bat file but rename it to FileWayInstall.bat 
4. Run FileWayInstall.bat 
 

12.3 Users do not want to enter their domain when u sing FileWay FBA 

 

Issue:  
Users do not want to enter their domain when using FileWay Form Based Authentication. 
Fix:   
Add the following key into the FileWay FrontEnd Web.config (default location is: Program 
Files\ENC\FileWay\FileWay FrontEnd\FileWay\Web.Config) 

 <add key="DomainName" value="DOMAIN_NAME" /> 
Replace the value DOMAIN_NAME with the actual domain name 
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12.4 Changing upload skins 
Issue: 
You want to change the look of the upload dialog. 
 
Fix: 

12.4.1 Changing upload skins for FileWay 3.5.0 and later 

Edit (i.e. open withe a text editor) the FileWay FrontEnd Web.config (located at: Program 
Files\ENC\FileWay\FileWay FrontEnd\FileWay\Web.Config by default). Find the section for upload skins as 
shown here: 

    <add key="FileWay_Upload_CSS_File" value="default-jquery-ui.css"/> 

    <!--<add key="FileWay_Upload_CSS_File" value="blitzer-jquery-ui.css"/>--> 

    <!--<add key="FileWay_Upload_CSS_File" value="cupertino-jquery-ui.css"/>--> 

    <!--<add key="FileWay_Upload_CSS_File" value="excite-bike-jquery-ui.css"/>--> 

    <!--<add key="FileWay_Upload_CSS_File" value="flick-jquery-ui.css"/>--> 

    <!--<add key="FileWay_Upload_CSS_File" value="humanity-jquery-ui.css"/>-->     

    <!--<add key="FileWay_Upload_CSS_File" value="mint-choc-jquery-ui.css"/>--> 

    <!--<add key="FileWay_Upload_CSS_File" value="pepper-grinder-jquery-ui.css"/>--> 

    <!--<add key="FileWay_Upload_CSS_File" value="redmond-jquery-ui.css"/>--> 

    <!--<add key="FileWay_Upload_CSS_File" value="start-jquery-ui.css"/>--> 

    <!--<add key="FileWay_Upload_CSS_File" value="sunny-jquery-ui.css"/>--> 

    <!--<add key="FileWay_Upload_CSS_File" value="ui-lightness-jquery-ui.css"/>--> 

To choose a skin, you can un-comment  the selected skin by removing "<!--" in the front, and "-->" at the end. All 
the other skins must be commented out. 

12.4.2 Changing upload skins for versions prior to 3.5.0 
 
1) Edit (ie. open with a text editor) the FileWay FrontEnd Web.config (located at: Program 
Files\ENC\FileWay\FileWay FrontEnd\FileWay\Web.Config) 
2) Search for the "RadUploadSkin" key. By default, it should be: 
 

<add key="RadUploadSkin" value="Telerik" /> 
 
3) Edit the value to another skin 
 
You can get a list of the skins by going to the upload skins directory located at: Program 
Files\ENC\FileWay\FileWay FrontEnd\FileWay\radcontrols\Upload\Skins 
 
Each folder represents a skin. So if you want to use the "Gold" upload skin, you would use: 

<add key="RadUploadSkin" value="Gold" /> 
 



 

 

12.5 Getting an “AUTH_PASSWORD null or empty!” erro r message 
Issue:  
When attempting to log into FileWay users see an “AUTH_PASSWORD null or empty!” error. 
Fix:   
Ensure ALL (FileWay FrontEnd, FileWay BackEnd, FileWayTEMP) virtual directories are set to use basic 
authentication in IIS. 
 

12.6 Single sign-on with OWA is not working  
Issue: 
Users are being prompted to log-on to FileWay when clicking the FileWay button in OWA. 
Fix:  
For Exchange 2007, the FileWay ISAPI filter needs to be installed. Refer to Section 4.2 for more detailed 
instructions. 
For Exchange 2010, the ENCAuthModule needs to be installed. Refer to Section 4.3 for more detailed 
instructions. 

 

12.7 With SSL enabled Users see an HTTP 403 error w hen logging in 

Issue: 

With SSL enabled, when logging into FileWay, the following error is displayed: 

 

 

Fix: 

You need to enter the correct URL to your FileWay BackEnd in your Web.config file. Refer to Secton 4.4 
for detailed instructions. 
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12.8 Installing a new instance of SQL Server Expres s Edition with the 
FileWay Installer 

Issue:   The FileWay Installer cannot connect to existing database server Instances and will not install a 
new instance. The SQL Server Instance used by FileWay MUST support Mixed Authentication and 
FileWay uses only a SQL Login, not a domain account to access the DB.  

If you are unsure how to configure the FileWay database during installation or you have errors while 
installing the database. 
Fix:  

Here are the steps for installing Microsoft SQL Server 2005 Express Edition for use with Everywhere 
Networks products using the FileWay Database. Please note that the installer should automatically  
install and configure the database server for you. See the Database Installation instructions in 
Section 3.1.1 above.  

1) If there is NO SQL Server or SQL Server 2005 Express Edition on the local machine, and the user 
agrees, the FileWay Installer  will launch the SQL Server 2005 Express Edition Installer from Microsoft. 

2) SQL Server 2005 Express Edition Installer will install a SQL Server 2005 Express Edition Instance on 
your machine named "FileWay3". 

3) The Installer SHOULD set both the MSSQL$FileWay3 AND the SQLBrowser Windows Services to be 
automatically started on your machine. 

4) When the Microsoft SQL Server 2005 Express Edition Installer is finished and has successfully 
installed, the Everywhere Networks Product installer will resume and will create the FileWay database 
and then resume installing the product. 

5) If for any reason the Product Installer reports a failure to install SQL Server 2005 Express Edition 
Instance or the database on that instance you should: 
 a) verify that the two services ("MSSQL$FileWay3" AND "SQLBrowser") are running and set to 
automatic start:       
To start the Service: 
  -- Start > Administrative Tools > Services > MSSQL$FileWay3 > start the service 
  -- Start > Administrative Tools > Services > SQLBrowser > start the service 

 b) run the Product Installer again -- it should detect your database server instance and install the 
database, if it does not do so go to c)  

 c) Verify that your SQL Server Express Edition is configured to allow remote connections as 
follows: 

    i.   Enable the TCP/IP protocol using the Surface Area Configuration Utility 

    ii.  Make sure the TCP/IP protocol is enabled in the SQL Server Configuration Utility 

     iii. Make sure the SQL Server browser is started. Note this step is optional. It is possible 
to set the SQL Server instance to use a fixed IP address    - but this is non-standard for 
named instances. See sqlexpress's WebLog from microsoft for details. 

     iv.  Make sure SQL Server and SQL Server Browser are exempted by the firewall on the 
server machine. This is done by putting sqlservr.exe and sqlbrowser.exe as an exception in the windows 
firewall.  

     v.   In order to get things to work. You might need to completely reboot the server 
machine after making the changes. There have been reports that starting and stopping the SQL Server 
and Browser software is not enough.  

 


